
             
Declaration of 
Conformity

DYMO Corporation
44 Commerce Road
Stamford, CT 06902-4561
Phone: (203) 355-9000
Fax: (203) 355-9090

Equipment Information
Description: Direct Thermal Printer
Models: LabelWriter 300 (90791), 330 (90792), 
330 Turbo (90793), EL40 (90644), EL60 
(90645), Turbo (90737)

This equipment has been tested and found to 
comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC (Federal 
Communications Committee) rules. These limits 
are designed to provide reasonable protection 
against harmful interference in a residential 
installation. This equipment generates, uses, and 
can radiate radio frequency energy, and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference to 
radio communications. 

However, there is no guarantee that interference 
will not occur in a particular installation. If this 
equipment does cause harmful interference to 
radio or television reception, which can be 
determined by turning the equipment off and on, 
the user is encouraged to try correcting the 
interference by one or more of the following 
measures:

! Reorient the receiving antenna.

! Increase the separation between the equipment 
and the receiver. 

! Connect the equipment to an outlet on a circuit 
different from that to which the receiver is con-
nected. 

! Use shielded cables to connect this device to 
computers.

! Consult the dealer or an experienced radio/TV 
technician for help. 
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You may find helpful the following booklet, prepared by 
the FCC: Interference Handbook. This booklet is available 
from the U.S. Government Printing Office, Superintendant 
of Documents, Washington, DC 20402-9325.

" WARNING: Changes or modifications to this unit not 
expressly approved by the party responsible for 
compliance could void the user�s authority to operate the 
equipment and void the manufacturer�s warranty. 

CE 
Certification

This device has been tested and complies with the 
requirements of:

The EMC Directive

EN55022: Radiated and Conducted Emissions B

EN50082-1: Generic Immunity ESD, RF, and Transient 
Susceptibility and Low Voltage Directive Product Safety 
EN60950

Copyright Copyright © 2001 DYMO Corporation. All rights 
reserved. Printing 3/01

Trademarks LabelWriter is a registered trademark of DYMO 
Corporation. DYMO is a registered trademark of Esselte 
Corporation. All other trademarks are properties of their 
respective holders. 
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Introduction

Your New 
LabelWriter

Congratulations on purchasing the DYMO 
LabelWriter. After a short time, you will realize 
how many of your daily tasks will be simplified 
by using the DYMO LabelWriter. 

Your LabelWriter will help you label file folders, 
diskettes, video cassettes, mail packages, name 
tags, and print Internet postage. With a little 
imagination, you will think of hundreds of ways 
to use the LabelWriter to make your job easier 
and more efficient. 

Features

Software The DYMO Label Software includes many 
features that make it flexible and easy to use. You 
can set your default return address so that you do 
not have to enter your address every time you 
print a label. You can import graphics to use with 
your labels, and select a default logo file so you 
don’t need to import your logo each time you 
create a new label. Of course, you can easily 
override these default values at any time. 

DYMO is even integrated into Microsoft® Word 
so that you can easily print labels directly from 
the Word toolbar.

Hardware Your LabelWriter printer does not use toner, ink 
cartridges, or a ribbon to print. The LabelWriter 
uses advanced thermal printing technology to 
print on specially treated labels.
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Thermal printing is based on the principle of heat 
transfer from the thermal print head inside the 
LabelWriter printer to the label. A row of 
miniature heating elements on the print head is 
pressed against the thermal labels. As a specific 
element generates heat, a thermal reaction takes 
place at that point on the label and the label 
becomes discolored. 

Labels The only supplies you will ever need for this 
printer are the labels. We recommend you only 
use DYMO brand labels.

How long your labels will last depends on how 
the labels are used. Thermal labels are susceptible 
to fading in two ways: 

! Exposure to direct sunlight or fluorescent light 
for an extended period of time will cause fading.

! Contact with plasticizers (for example labels 
placed on plastic ring binders) will cause fading.

In the original packaging, the label shelf life is 18 
months. When used for short-term applications 
(envelopes, packages, etc.), fading has never 
been reported as a problem. When used to label 
files in a file cabinet, fading is very gradual over 
many years. When applied to the edge of a 
notebook that is then placed on a shelf in the sun, 
fading begins within a few months.

When not in use, keep the labels stored in a cool 
dry place and in the black bag in which they were 
shipped to prolong label life.

Getting Help Before making labels you should be aware of the 
various help resources available to you. DYMO 
Label Software comes with extensive Help. At 
times in this manual, you will be directed to the 
Help for more detailed discussion or instructions 
on various topics. 

To access the Help: 

! Click LabelWriter Help on the Help menu.

The Help is opened in your Web browser.
2



              
Chapter 1
Getting Started
DYMO Label Software is a general-purpose label printing 
program that is specifically designed to help you get the 
most out of your LabelWriter printer. The program 
includes: 

! Many ready-to-use templates for common labels.

! A built-in Designer you can use to create your own 
templates.

! A built-in List Manager that lets you save addresses or 
other types of lists. 

! An add-in to print directly from Microsoft Word.

DYMO Label 
Window

The following figure introduces the features available from 
the DYMO Label Software main window

The first time you open DYMO Label Software, you are 
prompted to enter your return address and select a default 
logo. See "User Information" on page 23 for instructions 
on how to define your return address and select a default 
logo file.

SaveOpen Print Paste
Open List 
Manager

Open 
Designer

Template 
List

Label 
Workspace

Rulers
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Creating 
Your Own 
Label

This tutorial guides you through the steps necessary to 
create, print, and save a customized label. The best way to 
start is to learn how to modify one of the label templates 
included with the software. In this tutorial, you will 
customize a shipping label.

" You can only print this shipping label on wide print-head 
printers. Although the LabelWriter EL40 and 
LabelWriter 300 cannot print this shipping label, we 
recommend that you follow along. This tutorial will give 
you valuable information on how to access the various 
text and design objects and change their attributes. 

Choose a 
Template

The first step is to choose a label template as the basis for 
your new label. 

1. Click DYMO Label Software from the Apple menu to 
start the program. 

The DYMO Label window is displayed containing a 
blank label.

2. In the Label Templates box, click the Shipping with 
graphic (30256) template.

" The 30256 label is shipped with the EL60, Turbo, 330, 
and 330 Turbo model printers. If you have an EL40 or 
300 model printer, select this label anyway, and follow 
along with the exercise. 
4



 

Creating Your Own Label

                     
Notice that all templates are listed with the label type first, 
then any important objects on the template, and finally the 
part number of the label.

The Shipping with graphic (30256) template is 
displayed.

Changing the 
Graphic

The next step in this tutorial is to customize the graphic. 
As you will see, to modify an object’s attributes, you 
simply click the object. A dialog box appears that you can 
use to change the object’s attributes. 

To change the logo:

1. Click the telephone graphic that appears on the label. 

The Graphic Settings dialog box appears.

2. Click the File option under Select Image Source.

The Insert Image button changes to read Select File.

3. Click Select File. 

The Open dialog box is displayed listing the contents of 
the default clipart directory which contains the Business, 
Miscellaneous, and Sign folders.

4. Select the Miscellaneous folder and click Open. 
5
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The contents of the Miscellaneous folder are displayed.

5. Select the Comput1.jpg file. 

A preview showing the contents of the Comput1.jpg 
graphic file is displayed. 

6. Click the Open button. 

The Comput1.jpg graphic is displayed in the Graphic 
Settings dialog box.

7. Click OK. 

The computer graphic is displayed on the label replacing 
the telephone graphic.

Changing the 
Return 
Address

Next, you’ll change the return address. 

To enter the return address:

1. Click the text in the label’s upper-right corner. 

The Text Settings dialog box is displayed. 
6



Creating Your Own Label
2. Type the following text:

CompuDoctor’s Fix It Service
1234 Hardware Way
Livermore, CA 94550

3. Click OK. 

The return address is displayed on the label.

Changing the 
Recipient 
Address

Next, you enter DYMO’s address as the recipient. 

To enter the recipient’s address:

1. Position the arrow pointer over the address object.

2. Click the address object. 
7
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The Address Settings dialog box is displayed.

3. Type the following address into the Address Settings 
dialog box:

DYMO Corporation
44 Commerce Road
Stamford, CT 06902-4561

4. Click OK.

Changing the 
Font

You may want to modify the font used for the recipient 
address or return address. You can use the same font for all 
the lines in your address or make the first line different 
from the rest. For this tutorial, you’ll use the same font for 
all the lines.

To change the font for the address:

1. Click the recipient address object.

The Address Settings dialog box is displayed.

2. Click All Lines from the Font list. 

The Font dialog box is displayed.

3. If Arial is not selected, select Arial from the Font list and 
Bold from the Font Style list. 

4. Click OK to close the Font dialog box. 

5. Click OK to close the Address Settings dialog box. 
8



Creating Your Own Label
The address, formatted with Arial Bold type, is displayed 
on the label. Also, a POSTNET bar code encoding the 
address is displayed above the address.

Printing the 
Label

Now that you have customized the label, you are ready to 
print. 

" You can only print this shipping label on EL60, Turbo, 
330, and 330 Turbo printers. If you have an EL40 or 300 
printer, skip this section. 

Before you print the label, make sure:

! The LabelWriter printer is connected to your computer 
and turned on.

! You’ve properly loaded shipping labels in the printer. 

If necessary, see the Quick Start Card for information on 
how to set up your printer.

To print the label:

1. Click the Print button on the main toolbar. 

2. Click From and type 1 in each of the boxes.

3. Click the Print button.

Saving the 
Label

Now that you have created your shipping label, you can 
save it as a label template. Labels saved as template files 
will automatically appear in the Label Templates drop-
down list.

To save the label as a label template:

1. Click the Save button on the main toolbar. 
9
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The Save File dialog box appears and displays the 
contents of the default label file folder. 

2. Type the name MyShip in the File name box and click 
Save. 

Notice that your new label template, MyShip, is added to 
the top of the Label Templates list as the most recently 
used template and also alphabetically in the template list 
below. 

To use a template file you created, simply choose it from 
the Label Templates list and the label template is 
displayed with all the information you placed on the 
template.

" To access your label templates from the Label Templates 
list, you must store them in the label file directory. A 
default Label Files directory is created for you, under the 
DYMO Label installation folder, when you first install 
the software.

Now that you can open, edit, print, and save a shipping 
label, you are ready to use and/or modify most other label 
templates. Note that there are several different methods of 
saving your changes. In this tutorial you saved your label 
as a template and it will appear in the Label Template 
drop-down list. You can also save your label to a file. For 
more information, see "Saving Your Label to a File" on 
page 18.
10



Chapter 2
Using the Label
Designer

DYMO Label Software allows you to easily design labels 
for your specific needs using the simple-to-use Label 
Designer. You can also modify any of the label templates 
included with the software. 

The Label Designer allows you to change the appearance 
and content of labels. You can add or modify text 
(including addresses), bar codes, sequential numbers, 
date-time stamps, lines, and rectangles.The following are 
examples of custom label designs.

Object 
Definitions

A label created in DYMO Label Software can contain 
various text and design objects. Each object has certain 
attributes, such as: size, position, font, etc. You can edit an 
object’s attributes, simply by clicking the object (or 
double-clicking if the Designer is active). You can then 
select the attributes that you want in the dialog box that is 
displayed. For more information on modifying object 
attributes, see the Help. 

Below you will find a description of each of the objects 
available in DYMO Label Software.

Text The text object is useful for displaying information that 
remains unchanged every time you print a new label (for 
example, “Hello my name is” on name badges or your 
return address on shipping labels). By defining the text 
11



Chapter 2: Using the Label Designer
you are using as a preference setting and then copying the 
text into text objects, you are able to print labels with 
information on them that is static. (See "Default Return 
Address" on page 23.)

For convenience, DYMO Label Software includes a button 
to quickly insert the return address you entered when you 
first ran the program. Text objects can also be used for text 
that changes from label to label. This is useful for part 
numbers, book titles, and many other non-address items 
you might save in the List Manager. For more information 
on variable text, see the Help. To access the Help, select 
LabelWriter Help from the Help menu.

Address Address objects are designed to display addresses. They 
are similar to text objects, but are designed to print 
information that changes with each label printed, such as 
names and addresses. Address objects can also display 
POSTNET bar codes. You can change the font settings 
(font, size, style, and so on) for text in address objects and 
control the text’s position. DYMO Label Software also lets 
you apply special effects to the text.

Graphic The graphic object enables you to add your company logo 
and other favorite graphics to labels. You can import many 
popular graphic formats, position them anywhere on the 
label, resize them, and even specify one as the default 
graphic. You can also copy a graphic from a graphics 
application and then paste it into DYMO Label Software. 
You can import a graphic directly from a file or capture an 
image from a video device connected to your computer. 
After you insert a graphic, you can add a border of a 
specified size and color around the object.

" If you defined a default logo file, the graphic file you 
specified is displayed in any new graphic objects you 
place. See "Default Logo File" on page 23 for 
information about defining a default logo file.

Lines You can use horizontal and vertical line objects to improve 
a label’s appearance. Horizontal lines also function well as 
visual dividers on labels (for example, between the sender 
and recipient’s address on shipping labels). You can 
specify various shades of gray and the thickness of the 
lines. You can also hide lines that appear on labels.
12



Object Definitions
Rectangle/
Ellipse

Rectangle and ellipse objects, like line objects, primarily 
serve as design elements you can use to enhance a label’s 
appearance. A rectangle or ellipse can be used to create 
borders around other objects. You can specify shades of 
gray to fill the object. You can also specify the thickness of 
the object’s border.

Bar Code Bar code objects simply serve to display and print bar 
codes on your labels. You can use bar code objects to 
display fixed information you enter or link a bar code 
object to another object. When you link a bar code object 
to another object, the bar code object encodes the 
information contained in the linked object. Furthermore, if 
you change the information in the linked object, the 
program automatically updates the bar code object to 
encode the new information.

For example, you may want to link the bar code to a part 
number on a tag. When you update the part number text 
object on the label, the bar code object is updated 
automatically. You do not have to link the bar code to any 
other object.

For example, you may want to link the bar code object to a 
part number text object on a label. When you update the 
part number text object on the label, the bar code object is 
automatically updated. 

You can choose from many standard bar code symbologies 
including Code 39, Code 128, Codabar, UPC A/E, 
EAN 8/13, ITF-14 and Interleaved 2 of 5 bar codes.You 
can choose to include or exclude human readable text 
(alphanumeric information) and specify the font settings 
for the text. You can also select the bar code size and 
position.

Counter You can use counter objects to automatically number a 
series of labels. For example, you could use a counter 
object to automatically serialize a group of raffle tickets. 
You can also specify text you want to appear in front of 
and behind the counter (for example, “Disk # of ten”), as 
well as the starting number and the increments for 
counting (1,10,100, and so on). DYMO Label Software 
allows you to specify the font settings for the counter 
information, as well as other attributes.
13
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Date-Time You can use date-time objects to stamp the current date 
and/or time on labels using any one of a number of 
predefined formats. As with counter objects, you can 
specify the text you want to appear in front of and/or 
behind the date-time (for example, “Today’s date is”). 
DYMO Label Software offers a variety of date formats, 
including European formats. You can include or exclude 
the time and use the 24-hour time format (13:00, 22:00, 
and so on). You can control the font settings and other 
attributes for the date-time information.

Starting the 
Designer

When the Label Designer is active, the Design toolbar is 
displayed below the Main toolbar.

You can start the Label Designer in several ways:

! Open a new or existing Label file. 

! Click the Open Label Designer button on the Main 
toolbar

! Click View Design Toolbar from the Edit menu. 

Creating a 
New Label 
File

DYMO Label Software includes a blank label template for 
every type of available label. When you create a new label, 
you select one of these blank labels as a starting point.

To create a new label:

1. On the File menu, click New Label.

The New Label dialog box is displayed.

2. Select a label from the list that most closely matches the 
label you wish to create and click OK.

The blank label is displayed in the DYMO Label window 
and the Design toolbar is displayed below the Main 
toolbar.

Design Toolbar

Main Toolbar
14



Opening an Existing Label File
Opening an 
Existing 
Label File

Whenever you want to use a label file you have saved to 
disk, you simply open it. For convenience, the last four 
saved label files appear at the bottom of the File menu. 
You can then print the label as is, or modify it to suit your 
needs. 

To open an existing label file:

1. On the File menu, click Open or click the Open button.

The Open dialog box is displayed.

2. Select the file you wish to open and click Open.

The label opens in the window and the Design toolbar is 
displayed below the main toolbar.

Adding an 
Object

When you place a new object on a label, the new object 
displays certain default settings. For example, new address 
and text objects display text describing how to modify the 
objects. 

Although the various types of objects are quite different, 
the steps for placing all the objects on a label are nearly 
identical. The only difference is the tool button you select 
from the Design toolbar to place the desired object.

1. Click object that you wish to add on the Design toolbar.

2. Place the object where you want it on the label using the 
cursor.

If you select one of the object tool buttons, and then 
change your mind about placing the object, click the 
Cancel/Select Object button on the Design toolbar. This 
cancels object placement. 

" If you defined a default logo file, the graphic file you 
specified appears in all new graphic objects you place. 
See"Default Logo File" on page 23 for information 
about defining a default logo file.

Defining an 
Object�s Name

The program automatically assigns default names to the 
objects you place on labels. The default names reflect the 
object’s type. For example, new address objects are named 
Address. Also, you can select objects by name for certain 
DYMO Label Software features (for example, when you 
15
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link bar codes to objects and when you need to select the 
object into which you want to paste text). 

You can change the names of objects to make it easier to 
identify specific objects. 

To change the name of an object:

1. Control-click the object.

The Object Properties dialog box is displayed.

2. Type the name for this object in the Reference Name box 
and click OK.

Moving and 
Resizing 
Objects

DYMO Label Software gives you a lot of control over the 
size and position of objects on labels. When you activate 
the designer, you can use the mouse to drag objects where 
you want them to appear and increase or decrease their 
size. You can also rotate most types of objects. (See the on-
line help for information on how to align objects, resize 
multiple objects at the same time, and move objects in 
front of and behind each other.)

Moving 
Objects

You can change the position of objects on labels. DYMO 
Label Software gives you the option of using the mouse to 
move objects, or, for more precision, you can specify the 
exact position of an object. 

Moving an 
Object to a 
Precise 
Location

For precise positioning, use the Object Properties dialog 
box to position an object. This option lets you specify the 
position of the left and top sides of the object’s bounding 
box (the box that appears around a selected object) as well 
as its width and height. The position values you enter are 
measured relative to the label’s upper-left corner. 
16



Moving and Resizing Objects
You can specify position values in precise increments, 
depending on the current units of measure: English 
(inches) or metric (millimeters). 

Resizing 
Objects

You can change the sizes of objects on labels. DYMO 
Label Software gives you the option of using the mouse to 
resize objects, or, for more precision, you can specify the 
exact size of an object. 

Resizing an 
Object Using 
the Mouse

Using the small black squares or Edit Handles on a 
selected object to allows you to change its size. An edit 
handle appears on each corner of all selected objects 
except horizontal and vertical line objects, which only 
have edit handles on the ends.

" An object�s size affects the size of any text within the 
object. 

If you reduce an object’s size too much, the text inside the 
object may no longer fit inside the object. The program 
automatically decreases the size of the text to allow it to fit 
inside the reduced object. If you want to display the text at 
the original size, you need to increase the object’s size, or 
select Disable Shrink to Fit on the object’s Properties 
dialog box for the object.

Precisely 
Resizing 
Objects

You can specify the exact size of an object using the 
Object Properties dialog box. The size values you specify 
depend on the current units of measure. (See "Units of 
Measure" on page 24 for information on selecting the units 
of measure.)

About 
Unprintable 
Areas on 
Labels

The software will also prevent you from moving objects 
into these areas, stopping the movement when you reach 
the edge of the unprintable area.

Address Label Shipping Label

Top 0.04" 0.04"

Bottom 0.1" 0.11"

Left 0.21" 0.21"

Right 0.14" 0.14"
17
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The margins listed above apply to labels viewed in 
landscape orientation. Most labels will have similar 
margins to those above.

Rotating 
Objects

You can rotate objects (except lines, rectangles, and 
ellipses) in 90-degree increments. This option is useful for 
designing labels with vertically oriented text and graphics.

Tip:  If you rotate an object that contains text, you might 
need to resize the object to make all the text in the object 
appear at the correct font size.

Deleting 
Objects

To delete an object: 

1. Select the object with your mouse. 

2. Click the Delete button.

Saving Your 
Label to a 
File

After you design a label, you should save it to a file on the 
computer’s hard disk for future use. 

To save changes you have made to a label file: 

! Click the Save button on the Main toolbar or click Save 
from the File menu. 

The program overwrites the contents of the file with your 
changes.

To save the changed label as a new label file:

1. On the File menu, click Save As.

The Save File dialog box is displayed.

2. Type the name of your new label.

3. Select the LabelWriter Labels (.LWL) file type.

Your label design is saved as the new file name with the 
.lwl extension.
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Chapter 3
Using the List Manager
This chapter describes how to use the List Manager to 
create, edit, and print entries on labels.

To display the List Manager: 

1. Click the Open List Manager button, or click List 
Manager and then Open from the Edit menu. 

The last List Manager file you opened is displayed. The 
first time you open the List Manager, a sample address list 
is displayed.

You can use the List Manager to enter information in 
variable objects (address, variable text, or bar code) on the 
current label. If the current label contains no address 
objects, but does contain more than one other type of 
variable object, you must select the object into which you 
want the selected List Manager entry to appear. In this 
case, when you open the List Manager, a dialog box 
appears. Click the object you want to link to the List 
Manager and then click the Close Box in the upper left 
corner of the screen.

If the current label does not contain a variable object 
(address, variable text, or bar code), the program prompts 
you to open a label that contains one of these objects. This 
prompt appears because the program automatically links 
the List Manager to these types of objects. You can still 
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work on the List Manager without a variable object on the 
current label, but the List Manager will not link to the 
current label.

Rotating 
Names in 
Address Lists

In address lists, List Manager automatically sorts 
addresses by the last name. For example, if you enter the 
following address:

    Harrison Schreppel
    5040 El Cantada
    Berkeley, CA 94720-3828

Schreppel, Harrison is displayed in the Entries list. 

In some cases, the program cannot correctly identify the 
last name or incorrectly identifies a company name as a 
person’s name. In such cases, you can rotate the words in 
the entry’s first line to display the words in the correct 
order.

Printing an 
Entry

Typically, you’ll store addresses in an address list and then 
print selected addresses on address labels. Once you select 
the entry you want, List Manager will automatically copy 
the address information to the label. If no Address or other 
variable object is defined on the label you will be 
prompted to add one. 

You can also use the List Manager to store information 
other than addresses. This information (for example, a list 
of product numbers) can also be linked to a variable text 
object or bar code object (for example, to print a bar code 
label of every product number you carry). 

Creating a 
New List

DYMO Label Software lets you use either address lists or 
data list files. For address lists, the program automatically 
sorts entries using the first line of the address. If this is a 
person’s name, it will sort by their last name. However, if 
it is a company name, it will sort by the company name. 
For data lists, the program automatically sorts entries by 
the first few characters of each entry’s first line.

When you create a new file, the program gives you the 
option of importing addresses or data (for new address 
lists or data list files, respectively) into the new file. 
20



The program creates a new file with the specified name 
and stores the file in the default list file folder. The 
specified file name appears at the top of the List Manager 
dialog box. 

Opening an 
Address or 
Data List 

If you have more than one address list or data list file, you 
can open the one you want to use to create labels. Also, if 
you want to import addresses or data into a file, you must 
first open the file into which you want to import the 
information.

Importing 
Addresses or 
Data Into List 
Manager

To use an address or data list created in another 
application, you must be able to export it to a Comma 
Separated Values (CSV) file. For more information on how 
to import addresses or data into the List Manager, see the 
Help.

" When you create a new List Manager file, the program 
displays a prompt asking if you want to import addresses 
or data into the file now. Follow the directions in the 
Help to import information into the new file.

Exporting 
Data from List 
Manager

If you want to use information you have entered into List 
Manager in other applications, you can export it to a CSV 
file. Once in a CSV file, you can then import the data into 
a personal information management (PIM) database or 
other type of application. When you export data from the 
DYMO Label Software, the program exports each entry as 
a single record and each line as a single field. You can save 
the exported data in a CSV or text file.
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Chapter 4
Setting Preferences
This chapter describes how to define preferences allowing 
you to use the DYMO Label Software specifically for your 
needs. The preference settings you select remain in effect 
until you decide to change them.

The sections below are organized according to the drop-
down menu items available in the Preferences dialog box. 

User 
Information 

The User Information options are described below.

Default Return 
Address

If you entered your return address in the User 
Information dialog box, DYMO Label Software can 
automatically insert your Return Address information 
when you click on the Insert Return Address button, 
which is available on the Text Settings dialog box.

Click in the Default Return Address field and enter your 
return address. (If this field already contains an address, 
edit the address currently shown.) 

Default Logo File If you use a certain graphic over and over (such as your 
company’s logo), you can specify the file containing the 
graphic as a preference setting. Then, when you place a 
new graphic object on a label, the specified default graphic 
automatically appears in the new graphic object.
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General 
Settings 

The General Settings options are described below.

Units of Measure Select the English (Inches) button to use inches as the 
units of measure in DYMO Label Software; select Metric 
to use millimeters. The units you select are used for the 
rulers that are displayed on-screen, label dimensions, and 
the position and size values displayed in the Object 
Properties dialog box (see the "Moving an Object to a 
Precise Location" on page 16 for more information).

Display Rulers If the Display Rulers option is checked, horizontal and 
vertical rulers will be displayed beside the label. The rulers 
are in inches or millimeters, depending on the Units of 
Measure you have chosen. To remove the rulers, simply 
uncheck this option.

Show Shadows Check the Show Shadows box to display a shadow around 
the current label on screen; uncheck the box if you don’t 
want to display a shadow. (The shadow does not print on 
labels).

Show Print 
Progress Dialog

The Print Progress dialog box shows the number of 
copies printed and the remaining number of copies to 
print. The Print Progress dialog box appears on the 
screen each time you print labels; if you hide it, this dialog 
box will not appear. 

Select the Show Print Progress dialog box, within the 
General Settings dialog box, to display the dialog box 
during printing; uncheck this box if you don’t want the 
dialog box to appear. 
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Functional Settings
Display 
Compensation

The Display Compensation slider can be helpful if you 
are viewing DYMO Label Software on a large monitor, 
where the 100% size for zoom may not be accurate, such 
as a 19” or 21” monitor. By moving the slider left or right, 
you can adjust the size of the label on the screen. This 
allows you to view the label on the screen as the same size 
as the actual printed label.

Use POSTNET 
Bar Codes for 9 
Digit ZIP Codes 
Only

Check the Use POSTNET Bar Codes for 9-Digit ZIP 
Codes Only box to suppress POSTNET bar codes for 
addresses with five-digit ZIP codes; uncheck the box if 
you want to print bar codes for addresses with five-digit 
ZIP codes.

This preference setting does not apply to POSTNET bar 
codes you define for bar code objects.

Default Number 
of Copies

You can specify the default number of copies you want to 
print. DYMO Label Software automatically prints the 
specified default number of copies unless you specify the 
number of copies for the current label or change the 
default number of copies. 

To change the default number of copies, click the up/down 
Default Number of Copies buttons. When you close the 
Preferences dialog box, the specified default number of 
copies appears in the Copies field at the top of the DYMO 
Label window.

Functional 
Settings 

The Functional Settings options are described below.
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Paste Button 
Automatically 
Prints

You can extend the use of the Paste From Clipboard 
button by selecting the Paste Button Automatically 
Prints option in the Functional Settings dialog box. Each 
time you click the Paste From Clipboard button, the text 
from the clipboard is pasted into the current label and the 
label is printed automatically. This option simplifies the 
printing of labels when you have copied the information 
from other programs.

Always Start 
With This 
Template

Select the Always Start With This Template option to 
specify the label template to be opened each time you start 
DYMO Label Software.

Open Last 
Saved File

If you prefer, each time you start the program, you can 
automatically display the last “saved” label file. Select the 
Open Last Saved Label File option if you want the 
program to open this file each time you start the program.

Folders The Folders options are described below.

You can specify the default folders for label files and add-
in scripts. The folders you specify are used to store and 
open these two types of files.

Although default folders are set when the software is first 
installed, this feature is particularly useful when you store 
your files on a network. For example, you can store label 
files on a file server. 

In most cases, you can use the default folders defined in 
DYMO Label Software. These default folders are all 
automatically installed on your Macintosh when you 
install DYMO Label Software. You only need to change 
the default folders if you want to use other folders.
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The default folders you can specify are described below.

Label Files 
Folder

Specify the folder in which you want to store label files, 
label templates, and add-in templates. DYMO Label 
Software automatically selects the folder you specify 
when you save or open any of these label-related files. It’s 
important that you store all your label templates in the 
label file directory. DYMO Label Software only displays 
label templates located in the label file folder in the Label 
Templates list.

List Files Folder Specify the folder in which you want to store List Manager 
lists (address and data lists). DYMO Label Software 
automatically selects the folder you specify when you save 
or open List Manager lists. 

Clipart Folder Specify the folder in which you want to store graphics. 
DYMO Label Software automatically selects the folder 
you specify when you place graphics on labels and define 
a default logo file. 

Add-Ins Folder Specify the folder in which you want to store add-in 
scripts. It’s important that you store all your Add-in scripts 
in the specified folder. DYMO label Software can only 
access add-ins located in the folder.
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Chapter 5
Printing With Other
Applications

Most applications, including word processors and 
database managers, can use LabelWriter printers just like 
any other standard printers. This chapter explains how to 
print labels using the Microsoft Word Add-in. It also 
covers how to print to the LabelWriter using other 
applications.

Add-In for 
Microsoft 
Word

DYMO Label Software includes an add-in program that 
enables you to quickly print mailing labels from a 
Microsoft Word document. You access the add-in using an 
icon the LabelWriter software installs on the Word toolbar. 
The add-in works with Microsoft Word 98.

Installing the 
Word Add-In

The Microsoft Word Add-In is normally installed at the 
same time that you install the main DYMO Label 
Software. If it is already installed, you will see a small 
LabelWriter button in the main toolbar of Microsoft Word. 

If you don’t see this icon, and it cannot be enabled using 
the instructions below, you will need to reinstall your 
DYMO Label Software.   

" When you reinstall the DYMO LabelWriter Software, all 
of the supplied templates are also reinstalled. If you have 
made any changes to the supplied templates and not 
saved the changes with a new file name, copy the 
changed templates to another location before you 
reinstall the software so you don�t lose your changes. 
Then once the installation is complete, copy the 
templates back into the Labels folder.

When the Word Add-in is properly installed, you will see 
the LabelWriter button in the main toolbar of Microsoft 
Word. 
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Using the 
Word Add-In

To start using the Word Add-in:

1. Open Microsoft Word and type an address.

2. Click the LabelWriter button on the Word toolbar or 
choose the DYMO LabelWriter command from the 
Tools menu.

3. After a few seconds, the DYMO LabelWriter dialog box 
appears on the screen with the address from your 
document automatically placed in the Recipient Address 
Field. 

If your letter contains more than one address and you want 
to make sure the Word Add-In uses the correct one, simply 
select (highlight) the address in your Word document 
before you click on the LabelWriter icon.

Editing and 
Printing the 
Address

Once the LabelWriter dialog box is displayed, you can 
select among a number of different address and shipping 
label templates, depending on how you want the label to 
look. 

1. Select the desired label template from the Label Template 
list. 
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2. Click the Print Label button to print the label. 

If you need to make some changes to the address, simply 
edit the address inside the Recipient Address box and 
then click the Print Label button. If you are printing a 
Shipping Label template, it will include the return address 
that’s already been defined for the template. See "Editing 
the Label Templates" on page 31.

Printing 
POSTNET Bar 
Codes

The LabelWriter dialog box also gives you the option of 
printing POSTNET bar codes on the label, either above or 
below the recipient address. The POSTNET bar code 
option only works on US addresses and should only be 
used for addresses with a complete nine-digit ZIP+4 code. 

Editing the 
Label 
Templates

The Word Add-In comes with pre-defined label templates 
for the most commonly used address and shipping labels. 
You can use these templates as is, or you can modify them 
to suit your needs. The following example provides step-
by-step instructions for modifying one of the existing 
shipping label templates.

1. Choose Shipping (30256) from the Label Template list 
in the DYMO LabelWriter dialog box.

2. Click the Edit Label Template button which appears 
beside the Label Template field. 

DYMO Label Software opens with the Shipping (30256) 
template displayed.

3. Click the text object at the top of the label to input the 
return address. 
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The Text Settings dialog box appears.

4. Type in your return address. Then use the Justification, 
Alignment, and Fonts options to customize the return 
address block to suit your needs. When finished, click OK 
to close the Text Settings dialog box.

5. To modify the width of the horizontal line dividing the 
Return Address from the Recipient Address, click on 
the line. 

The Line Settings dialog box appears.

6. Click the line width you want, and then click OK to close 
the Line Settings dialog box.

7. Next, you can change the formatting of the Recipient 
Address by clicking on the Recipient Address. 

The Address Settings dialog box appears. 

8. Use the Justification, Alignment, and Fonts options to 
customize the address block to suit your needs. When 
finished, click OK to close the Address Settings dialog 
box.

9. Click Save from the File menu. 

The program saves the changes that you’ve made to the 
Shipping (30256) template.

Printing 
With Other 
Applications

Applications of all sorts, including word processors and 
database managers, can use LabelWriter printers just like 
any other standard printer. This section explains how to 
print to the LabelWriter using applications other than 
DYMO Label Software.
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Choosing The 
LabelWriter

Before you can print to the LabelWriter, you must select it 
in the Chooser.

1. Click Chooser from the Apple menu.

The Chooser is provided by Apple Computer as part of the 
Mac operating system (OS). If it doesn’t appear in your 
Apple menu, you may need to reinstall the Mac OS on 
your startup disk.

2. Click the LabelWriter icon in the scroll box at the left of 
the window.

If your DYMO printer icon doesn’t appear, make sure the 
printer driver file is in the Extensions folder.

3. Select the port to which the printer is connected from the 
choices displayed in the scroll box at the right of the 
window.

4. Make sure Background Printing is turned on.

If Background Printing is off, whenever you print to the 
LabelWriter, a small alert box displays the status of the 
print job. You won’t be able to perform any other 
operations on your Mac until the entire print job is 
completed.

In contrast, if Background Printing is on, the Mac 
quickly saves the print job to a temporary file on disk and 
automatically launches the SpoolMaster which begins 
printing labels while allowing you to continue working in 
another program. 

5. If you want to check the status of a print job, choose 
SpoolMaster from the Applications menu at the far right 
of the menu bar. The name of the current job appears at the 
top of the window, followed by the names of any other 
jobs waiting to be printed. 

In the Printing Status box at the bottom of the window 
you can see how many pages (labels) remain to be printed, 
and a thermometer shows the current page progress. Click 
Cancel Printing to stop the current print job if necessary 
for whatever reason. 

6. Click the close box in the top left corner of the Chooser 
window.

Changes to output device selections don’t take effect until 
the Chooser window is closed. Now whenever you choose 
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Print from an application’s File menu, the document will 
be sent to the LabelWriter. Follow the instructions on the 
next few pages to properly configure the Page Setup 
dialog box.

Specifying the 
Page Setup Choosing the LabelWriter is just the first step. Every time 

you switch printers in the Chooser, you must change the 
Page Setup so that your documents print as intended.

1. Launch the application from which you wish to print.

2. Choose Page Setup from the File menu.

3. Specify the type of labels in your printer by clicking the 
appropriate Paper radio button or choosing from the pop-
up menu.

4. If using a non-standard label, click Paper, then click New.

The Paper dialog box shows a list of the different label 
types, along with the dimensions and margins of each.

In the Name text field, enter a descriptive name for the 
type of label you are using.

Using the Units radio buttons, specify your preferred unit 
of measurement, then enter the Width (side to side) and 
Height (top to bottom) in the corresponding text fields. 

The standard margin settings are appropriate for most 
labels, but you may change them by clicking the Custom 
radio button and entering whatever values you wish.

When everything has been entered to your satisfaction, 
click Set to save your settings, or click Reverse to discard 
them. Continue creating as many custom label types as 
you wish, then click OK to return to the Page Setup 
dialog box.

5. Select the Continuous checkbox only if using continuous 
thermal paper.

6. Specify the correct Orientation by clicking on the 
appropriate icon.

7. Click Options to open a dialog box allowing further 
manipulation of how labels are printed.

Select as many check boxes as desired. The page 
thumbnail shows the combined effect of the check boxes 
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on the labels. These options are used primarily for labels 
containing only graphics. When used with text, the Flip 
Horizontal check box prints the text backwards and the 
Flip Vertical check box prints a mirror image. The Invert 
Image check box prints a negative image.

When satisfied with your specifications, click OK or click 
Cancel to close the dialog box without making any 
changes.

8. To reduce or enlarge the information to be printed on the 
label, enter the desired percentage.

9. If you’ve made any changes to the Page Setup dialog box, 
click Settings.

10.Click the appropriate radio button to either save the 
current settings as the new user default, restore the old user 
default, or restore the factory default settings.

11.When satisfied with your Page Setup specifications, click 
OK or click Cancel to close the dialog box without 
making any changes.

Creating 
Custom 
Templates

After choosing the LabelWriter and specifying its Page 
Setup, you can print any type of document from any kind 
of application with a Print command. However, you must 
set up your program according to its user manual for 
printing to labels. For instance, if your program requires 
you to set up layouts or templates, you must create one 
specifically for printing to the LabelWriter. The following 
pages describe how to create templates for Microsoft Word 
98. For technical support on how to create templates for 
FileMaker Pro and other applications, visit 
www.dymo.com/support.

Printing to the LabelWriter from word processors is really 
no different than printing to any other kind of printer. 

Instructions for using Microsoft Word 98 follow, but as 
each program is slightly different, refer to your word 
processor’s manual for specific help on formatting the 
page.

1. Launch Word by double-clicking its icon. 

2. If one wasn’t automatically created, open a new blank 
document.

3. Choose Page Setup from the File menu.
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4. Click Custom, deselect the Custom Paper Size check 
box, then click OK. 

5. Choose the appropriate Paper setting, then click OK.

6. Click Page Layout from the View menu to display the 
page boundaries.

7. Click Document from the Format menu and enter the 
desired margins.

8. Enter whatever you want to print on the label, adjusting 
the type specifications and margins as necessary.

9. Click Print from the File menu.

The standard LabelWriter Print dialog box contains 
Word’s options at the bottom.

10.Make any adjustments necessary; then click Print.

11.If everything is acceptable, click Save from the File menu 
to save the document as a template so you needn’t redo the 
formatting every time you want to print.

Now, whenever you want to print from Word, select the 
LabelWriter in the Chooser, open your template, and then 
click Print just as you normally would with any other 
printer.

General Tips As explained on the previous pages, it’s easy to print 
directly to the LabelWriter with most applications. 
Although we’ve detailed the steps necessary for Microsoft 
Word 98 only, the following general tips can be applied to 
other applications as well.

! Select the LabelWriter in the Chooser and click Page 
Setup from the File menu before trying to print.

! Reselect your main printer (such as, LaserWriter, 
ImageWriter, etc.) when finished with the LabelWriter. 
Otherwise you may inadvertently print a document to the 
wrong printer.

! Eliminate any headers or footers that your program may 
put in as defaults.

! Make sure page margins are not too big for the labels 
loaded in the LabelWriter. Otherwise, portions of your 
document may get clipped.
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" Once you have selected the port the LabelWriter is 
connected to in the Chooser, you will not need to return 
to the Chooser when using the LabelWriter Software.

Mail Merging Mail merging is a process in which you create a form letter 
in a word processor, then you print a batch of letters with 
the computer automatically filling in the blanks with data 
from a separate file, usually generated by a database.

Mail merging is much easier than typing individual letters 
to each recipient, but you still need to print labels for each 
letter printed. Without a LabelWriter, such a task can be 
daunting. However, printing labels to accompany a mail 
merge is a breeze.

1. Follow your word processor’s instructions for setting up a 
form letter and data file.

2. Choose your page printer in the Chooser.

3. Choose the Print Merge option in your word processor, 
and proceed as you normally would.

Your word processor reads comma- or tab-delimited data 
from the address data file. It then prints a form letter on the 
page printer after inserting this info in the right fields. 

4. After all of the letters have been printed, highlight the 
address block that appears on the form letter (including the 
mail merge commands), then copy this to the Clipboard.

5. Open the previously created LabelWriter template for this 
application.

6. Paste the address block, which contains all of the 
necessary mail merge commands, onto your template.

7. Switch to the LabelWriter as the output device in the 
Chooser.

8. Choose Page Setup from the File menu so that the word 
processor knows about the newly chosen printer.

9. Choose the Print Merge option in your word processor.

The word processor reads the same comma- or tab-
delimited data from the address data file, but this time it 
prints to the LabelWriter.
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Chapter 6
Maintenance and
Troubleshooting
This chapter describes how to take care of your 
LabelWriter and offers suggestions for identifying 
problems that can occur when you use the LabelWriter 
printers. If you cannot solve the problem, this chapter also 
describes how to contact DYMO for technical support.

Maintenance The section below describes how to care for your 
LabelWriter.

Caring for 
Your 
LabelWriter

The LabelWriter printer is designed to give you long and 
trouble-free service, while requiring very little 
maintenance. You’ll get the best possible performance 
from your LabelWriter if you follow the setup instructions 
that appear in the Quick Start Card and the procedures 
described in this section. 

You can easily clean your LabelWriter using just a few 
simple items, which are listed below. 

! Lint-free cloth. 

! Isopropyl alcohol, diluted dishwashing detergent, or 
diluted glass cleaner. (If you use glass cleaner, make sure 
it does not contain ammonia.)

! Small, soft brush, such as a paint brush. 

! LabelWriter cleaning card. One cleaning card (part 
#60622) is included in your printer package. To purchase 
additional cleaning cards, visit www.dymo.com or call 
(800) 426-7827.

To keep your LabelWriter working properly, you should 
clean it from time to time. Dusting the outside of the 
printer occasionally will help keep foreign matter from 
getting inside the printer. However, it is still a good idea to 
periodically perform some basic interior maintenance. 
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To clean the exterior and interior of your printer: 

1. Turn off the printer and disconnect the power cord. 

2. Use the lint-free cloth to wipe the exterior of the printer. 
Remove dirt and smudges with one of the cleaning 
solutions mentioned above. 

3. Open the top cover. 

4. Use a small, soft brush/cotton swab to whisk away paper 
dust and other stray particles from the inside of the printer.

5. Remove the roll of labels to clean under the roll. 

6. If you have a LabelWriter Cleaning card, follow the 
instructions printed on its packaging and feed it through 
the printer mechanism.

7. Reconnect the power cord and turn on the printer.

8. Reload the roll of labels and close the top cover. 

Trouble-
shooting

The sections below describe how to identify and resolve 
printer problems. Additional troubleshooting steps may be 
found in the Help.

Performing a 
Printer 
Self-Test

If you experience problems with broken characters or 
other print quality issues, you should perform a printer 
self-test. The self-test verifies that all elements of the print 
head are in working condition. 

To perform a self test: 

1. Turn off the printer (using the switch on the back of the 
printer). 

2. Press and hold down the form-feed button.

3. Turn on the printer and then release the form-feed button.

Your LabelWriter will print vertical lines along the width 
of the printer. To change the test pattern being printed, 
press the form feed button.

4. Turn the printer off to stop the self-test and reset the 
printer.
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Technical 
Support

If you experience problems with the set up or use of your 
LabelWriter, carefully read this manual and consult the 
on-line help to make sure you have not missed something 
that is covered in the documentation. 

If you cannot resolve your problem by consulting the 
documentation, you can obtain additional information and 
assistance from DYMO. 

Contacting 
DYMO

DYMO maintains an Internet Web site, www.dymo.com, 
that offers support for each LabelWriter printer.

DYMO’s technical support department is also available by 
phone and fax between 9 A.M. and 8 P.M. Eastern time.

Web site:  www.dymo.com
Phone:  (203) 588-2500
Fax:  (203) 588-2560

Visit the Support section of our Web site at 
www.dymo.com to contact us by e-mail.

Warranty DYMO warrants the LabelWriter against defects in 
materials and workmanship for a period of one (1) year 
from the date of original retail purchase. If DYMO 
receives notice of such defects during the warranty period, 
DYMO will, at its option, either repair or replace printers 
that prove to be defective.

Warranty 
Exclusions

This warranty does not cover customer abuse or accidental 
damage. DYMO’s sole liability is limited to supplying the 
parts and labor required to restore the warranted product to 
its normal operating conditions. This warranty is in lieu of 
all other warranties, express or implied, and in no event is 
DYMO Corporation liable for consequential or incidental 
damage incurred by the user.

Returning 
Your 
LabelWriter 
for Service

In order to claim warranty coverage, dated proof of 
purchase for the LabelWriter printer is required. 

" Please DO NOT send products to DYMO without first 
obtaining a Return Authorization (RA) number. 
Packages shipped without an RA number will be 
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returned to you. This applies to both warranty and out-
of-warranty repairs.

Obtaining an RA 
Number from 
DYMO

Contact DYMO’s technical support department at 
(203) 588-2500 between 9 A.M. and 8 P.M. Eastern time. 
A technical support specialist will ask you to describe the 
problem and provide the product’s serial number. Upon 
confirmation of the defect, the service representative will 
fax a Return Authorization (RA) form to you to complete. 
Once the completed RA form is received by DYMO, an 
RA number will be issued to you. 

Shipping the 
Printer to DYMO

The RA number must be clearly written on the side of the 
shipping container in which you return the LabelWriter. 
DYMO will not accept any return without an RA# marked 
on the outside of the box. The product must be sent to us 
freight prepaid.

Send the product to DYMO’s repair center at:

DYMO Service Center
RA#xxxxx (place your RA# here)
83 Harvard Avenue
Stamford, CT 06902-5506

DYMO will repair the defects covered under warranty at 
no charge in approximately three working days. DYMO 
will return the repaired product to you using an equivalent 
shipping method. 

The original warranty on the printer remains – it does not 
restart from the repair date. 

Out of 
Warranty 
Repairs

Repairs made to out-of-warranty printers are billable and 
will only be made after your authorization.
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Appendix A
Networking the
LabelWriter

This appendix describes the networking aspects 
of the LabelWriter printer.

Connecting to 
a LabelWriter 
Over a 
Network

The LabelWriter is a stand-alone device. Any 
attempt to print to a LabelWriter through a 
LocalTalk adapter will fail. The only way to 
connect a LabelWriter to a network is to use 
Stalker Software’s Portshare Pro. For more 
information, contact Stalker Software at 
(800) 262-4722 or (415) 383-7164 or visit their 
Web site at www.stalker.com.

Other 
Networking 
Solutions

For the latest information on networking the 
LabelWriter, visit our Web site at 
www.dymo.com/support.
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Appendix B
Labels & Accessories
This appendix describes the various types of 
labels and accessories that you can use with your 
LabelWriter.

Labels DYMO offers dozens of labels for addressing, 
shipping, file folders, media, name badges, and 
much more. A complete listing can be found in 
the label catalog that was supplied with this 
printer and at www.dymo.com.

Custom Labels DYMO also offers several ways to customize 
your LabelWriter labels. First, you can order 
labels preprinted with text or graphics in any 
color. A good example is Shipping labels 
preprinted with your return address and logo to 
match your corporate letterhead. 

Second, labels are available in custom sizes. 

Finally, labels are available with special 
adhesives. 
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You can obtain details through our custom label program 
two ways:

! Visit the DYMO Web site at www.dymo.com.

! Call the custom label Sales department at 800-426-7827 
extension 9153.

Accessories

Spare Parts Here is a list of the most commonly requested parts for the 
LabelWriter EL40, EL60, Turbo, 300, 330, and 330 Turbo 
printers.

To order any of the parts: 

! Go to www.dymo.com and click Accessories from the 
links on the left.

! Contact Sales at 800-426-7827. 

Description Part #

Adjustable Label Spool
(only available in gray)

91013

Macintosh Serial Cable 90253

Power Cable 90415

USB Cable 90629
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Appendix C
Technical Specifications

Printer 
Specifications Print Method Direct Thermal

Print Resolution

EL40, EL60, Turbo

300, 330, 330 Turbo

203 dots per inch

300 dots per inch

Print Speed*

EL40, EL60

300, 330

330 Turbo, Turbo

*for standard 4-line address

12 labels per minute

16 labels per minute

30 labels per minute

Maximum Print Width

300, EL40

330, 330 Turbo,
EL60, Turbo

1.57" (40mm)

2.25" (56mm) 

Maximum Media Width 2.44" (62mm) in all printers

Maximum Label Length User-definable

Maximum Paper 
Handling

300 feet of thermal paper; 
1200" of labels

Dual Interface Bi-directional, serial RS232

USB Spec 1.1 protocol

Serial Printer Settings

EL40, EL60

300, 330,
330 Turbo, Turbo

19,200 baud, 8 data bits, no 
parity, hardware handshaking

115,200 baud, 8 data bits, no 
parity, hardware handshaking

Dimensions 4 7/8" x 5 3/4" x 7 1/4" 
(WHD) 

Weight 1 1/4 pounds
47



Appendix C: Technical Specifications
LabelWriter 
Developer 
Information

DYMO provides various types of information designed to 
help developers create products that work with the 
LabelWriter printers and DYMO Label Software. Below 
are some notes for those interested in developing products 
that work with LabelWriter printers.

! Keep in mind that LabelWriter printers use standard 
printer drivers. Therefore, printing to a LabelWriter is no 
different than printing on a laser printer, except that the 
pages are smaller. 

! You can check the Developer’s forum on the DYMO Web 
site at www.dymo.com/developers for the latest news. 
Also, you can join the Developer’s mailing list to obtain 
developer-specific news and announcements.

Average Print Head Life 2,000,000 linear inches (over 
31 miles)

Power Requirements 100-240V ~ 850mA 47-63 
Hz, Class II

The LabelWriter printer’s 
internal power supply allows 
you to use it Worldwide with 
an appropriate adapter.

Regulatory Approvals

EL40, EL60

300, 330,
330 Turbo, Turbo

CE, FCC, CSA, TUV, 
C-Tick, and GS 

CE, FCC, cTUVus, GS and 
C-Tick

Warranty One Year Limited
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